Now let's take a look at how we generate the mine and overburden grids from AutoCAD
The case study we are going to examine is a multiple-seam situation in the steep topography of eastern Kentucky.

The overburden here ranges from outcrop to over 500 m in about 1500 m of horizontal distance.
The upper Darby Fork Mine in the area of interest is 1.5 m thick and about 285 m deep.

This mine had retreated the pillars in two sections that were seven entries (125 m) wide,
and left a 18-20 m wide barrier pillar between the sections.
The lower Huff Creek Mine is 15 m below the Darby Fork Mine and averages about 1.8 m thick
The Huff Creek Mine was trying to drive their seven entry mains to the north under the barrier pillar in the Darby Fork Mine when the stress conditions forced the mine to change the direction of advance to the west.
The pertinent section of the mine map for these two mines is in the file: “Huff&DarbyTutorialM.dwg”

Please open this file in AutoCAD.

Next, to understand this drawing a little better, please open the AutoCAD layer manager using the “layer” command
In the layer manager, it can be seen that the drawing contains a number of layers.

Layers with the Darby Fork (DF) pillars and gob, a layer of Huff Creek (HC) pillars, a GridOutline layer with the desired grid area, and the Overburden and Overburden Grid (OvbGrid) layers.
To get started generating the mine grid for the Huff Creek Mine, let's make the HCPillar layer “Current” (by clicking on the layer name and then clicking on the green check mark above).

Then, let's turn off all of the layers except:

The Huff Creek Pillars (HCPillars), and the Proposed grid area (GridOutline) (see above).
Next, zoom in on the area of interest until the drawing looks similar to above.

In this drawing, in order for the grid generation to work correctly, the pillars all have to be **Closed Polylines**
Also, for the virgin coal around the edge of the excavation, it has to be enclosed in “Pseudo Pillars” in order to included as coal by the grid generator.

Most of the work in generating the grid comes in properly preparing the mine map so that all pillars are closede polylines and all surrounding coal is in pseudo pillars. Once this is done, the grid generation software works pretty fast.
Now, in order to start the grid generation, we need to load the AutoCAD Run-Time Extension (arx) file which contains the commands we need for LaModel grid generation.
Go to the AutoCAD main bar and select the “**Tools**” pull-down menu, and then click on “**Load Application**”
(or type “Appload” from the command line)
This brings up the “Load/Unload Application” form.

Go through your directories to find the “StabilityMapping” software that is appropriate for your version of AutoCAD.

In this case, the Stability Mapping arx files are in the “Workshop Working Files” sub-directory and I am using a 64 bit version of AutoCAD 2013, so I choose the file “StabilityMapping2013(X64).arx” and double click it (or click the “Load” Button).
If the .arx file loads successfully, you will see a message at the bottom of the form:

“StabilityMappingXXX.arx successfully loaded”, and


If it does not load successfully, check the version of AutoCAD and/or try another version of Stability Mapping.
Next, close the “Load/Unload Application” form, and click on the “Stability_Mapping” pull-down menu.

There are a lot of commands in the Stability_Mapping pull-down menu that we no not presently need.

Please click on the “Seam Grid Generation for LaModel” command about 2/3rds of the way down the menu.
This opens the “Seam Grid Generator for LaModel” form.

In this form, we first need to specify the location and size of the seam grid.

So, click on the “pick point” button in the upper right, so we can pick the coordinates of the grid origin.
This opens the AutoCAD drawing menu, where we first make sure that “Object Snap” is on and then

Snap to the lower left corner of our desired mine grid location
This brings us back to the grid generation form with the coordinates of the origin (854380, 62780) inserted in the correct boxes.

We then specify our desired **Cell Width** of 3 by 3,
And our desired **Number of Cells** of 150 by 150.

To check the size and position of our grid, we can click the “**Preview Grid**” button to see the grid on the map.
The drawing of the grid looks fine, so we just hit the “Enter” key to dismiss the drawing.
Next, we click on the “Build Grid” tab in the Grid Generator form.

In this tab, we locate our working directory, and supply the file name to hold our seam grid: “HCPillars.txt”
Then, we select the pillar layer “HCPillars” and make sure that our coal material is “A”

Finally, click the “Build Grid” button to start building the seam grid.

At this point, AutoCAD counts the pillars and gives a warning that there are overlapped pillars (not a problem)
Hit the “Enter” key to continue.
AutoCAD then shows the progress of the grid generation, and finishes with a plot of the coal element in red and the opening elements in green.

Typically, you do not want to same this plot of the seam grid, but rather save the seam grid file.

So, hit the “Enter” key to continue.
Back in the Grid Generator form, click the “Save Grid” button to save the grid.
AutoCAD then asks for confirmation on saving the grid file.

Click the "OK" button to save the HCPillars.txt grid file.
With a “small” grid, it can be edited in AutoCAD

To see how this work, click the “Edit Cells” button.
This opens a drawing with the colored seam grid in edit mode. (remember to turn off “Object Snap”)

In this mode, the user can click inside any cell and cycle it from Coal (red) to Gob (yellow) to Opening (Green). With the pillars showing behind the grid, this is a good way/place to fine tune the grid.

When you are finished with edit mode, hit the “Enter” key.
Now, you need to re-save the edited grid by clicking the “Save Grid” button.

And we are now done building the seam grid for the Huff Creek Mine, so we click the “OK” button to exit.
Next, we need to build the seam grid for the Darby Fork Mine. To prepare for the Darby Fork Mine, let’s change the layers appropriately.

Please open the layer manager form with the “layer” command
First, let’s **turn on** the Darby Fork pillars (**DFPillars**) and Darby Fork gob (**DFGob**) layers.

Then make the **DFPillars** layer “**Current**” by clicking on the layer name and then clicking on the green check mark above.

Then, let’s **turn off** the Huff Creek Pillars (**HCPillars**) layer (see above).
The AutoCAD drawing should now have the Darby Fork pillars (shown here in green) and Darby Fork gob (shown here in red) and the grid outline visible.
Then, we want to go to the “Stability_Mapping” pull down menu and select the “Seam Grid Generation for LaModel” command.
This opens the Grid Generator form and the location and size from the last grid (which we need for the present grid) are still entered.

Just to check, we can click the “Preview Grid” button
The drawing of the grid looks fine, so we just hit the “Enter” key to dismiss the drawing.
Next, we click on the “Build Grid” tab in the Grid Generator form.

In this tab, we locate our working directory, and supply the file name to hold our seam grid: "HCPillars.txt"
Then, we select the pillar layer, “DFPillars”, select the gob layer, “DFGob” and make sure that our coal material is “J”, and our gob material is “S” (The material code selection will be explained in LamPre)

Finally, click the “Build Grid” button to start building the seam grid.
At this point, AutoCAD counts the pillars and gives a warning that there are overlapped pillars (not a problem)
Hit the “Enter” key to continue.

Then AutoCAD counts the gob areas and asks if you want to continue
Hit the “Enter” key to continue.
AutoCAD then shows the progress of the grid generation, and finishes with a plot of the coal elements in red, the gob elements in yellow and the opening elements in green.

You do not want to same this plot of the seam grid, but rather save the seam grid file.

So, hit the “Enter” key to continue.
Back in the Grid Generator form, click the “Save Grid” button to save the grid.
AutoCAD then asks for confirmation on saving the grid file.

Click the “OK” button to save the DFPillars.txt grid file.

We are done creating the Darby Fork Seam grid, so click the “OK” button to exit the Grid Generator form.
Next, we need to build the **Overburden Grid** for the Huff Creek Mine. To prepare the drawing, let’s change the layers appropriately.

Please open the layer manager form with the “**layer**” command.
First, let’s **turn on** the Overburden (Overburden) and overburden grid (OvbGrid) layers.

Then make the Overburden layer “Current” by clicking on the layer name and then clicking on the green check mark above.

Then, let’s **turn off** the DFPillars, DFGob and GridOutline layers (see above).
After zooming appropriately, the AutoCAD drawing now has the Overburden contours and Overburden grid visible.

In order to properly interrupt the overburden grid from the overburden contours, the contour lines must be at the correct vertical coordinate as marked (i.e. the 300 m line must have a z coordinate of 300)
Now, to build the overburden grid, we want to go to the “Stability_Mapping” pull down menu

and select the “Topography Grid Generation for LaModel” command
This opens the “Topography Grid Generator for LaModel” form.

In this form, we first need to reset the location and size of the grid for the overburden grid.

So, click on the “pick point” button in the upper right, so we can pick the coordinates of the grid origin.
This opens the AutoCAD drawing menu, where we first make sure that “Object Snap” is on and then

Snap to the lower left corner of our desired overburden grid location
This brings us back to the grid generation form with the coordinates of the origin (854230, 62630) inserted in the correct boxes. (Note that the Overburden grid is 150 m larger on all four sides than the mine grid)

We then specify our desired **Cell Width** of **10** by **10**, and our desired **Number of Cells** of **75** by **75**. (Note that the overburden grid can have larger elements than the mine grid, 1/20 to 1/10 of the depth)
To check the size and position of our grid, we can click the “Preview Grid” button to see the grid on the map.

The drawing of the grid looks fine, so we just hit the “Enter” key to dismiss the drawing.
Next, we click on the “Build Grid” tab in the Grid Generator form.

In this tab, we locate our working directory, and supply the file name to hold our Overburden grid: “HuffCreek.top”
(Note: for LaModel to automatically find the overburden file, it must have the same base name as the input file (i.e. HuffCreek.inp).

Also, we select the contour layer as “Oveburden”, and set our Units at “Meters”
Finally, click the “Build Grid” button to start building the overburden grid.

At this point, AutoCAD counts the contour lines and asks for permission to continue. Hit the “Enter” key to continue.

(The overburden grid generation can take a while, so be patient)
When the overburden grid generation is finished, AutoCAD plots a colored version of the grid for a quick validation check.

This overburden grid looks like it matches the contour lines very well.

So, hit the “Enter” key to dismiss the plot and continue.
Back in the Grid Generator form, click the "Save Grid" button to save the grid.
AutoCAD then asks for confirmation on saving the grid file.

Click the “OK” button to save the HuffCreek.top grid file.

We are done creating the overburden grid, so click the “OK” button to exit the Grid Generator form.
We are done generating the seam and overburden grids in AutoCAD, so go to “File” pull-down

and click the “Exit” to exit the program
Now, with the seam grids and overburden grid available, we can open the preprocessor, **LamPre**, and build the input file.

(If you have a “PRE” icon on your screen, you can double click on it, or you can use the start menu as shown below.)

Click on: **Start=>Programs=>WVU=>LaModel=>LamPre3.0.2**

This will start LAMPRE, and the first thing that you may see is the Disclaimer.

Click on: **OK** to accept the disclaimer and the main LamPre window will appear.
In the Main LamPre window, to start inputting the project parameters

Click on: **Edit-Data** on the menu bar

Next Click on the “**Project Parameters**” command to begin entering parameters for our model in the **Projects Parameters** form
In this form, we can enter a title, in this case “HuffCreek” (a shortened version of the mine name). Next we set:

- **Number of Seams** = “2”
- **Number of In-Seam materials** = “19”
- **Number of Steps** = “1”, and
- **Current Units** = “m, MPa” – International units
For materials, we plan to use 4 yield zones per seam. With 2 materials per yield zone and a core elastic element, this results in 9 material per seam; and therefore, 18 material for the coal in both seams. Plus, we need a gob material for the Darby Fork Seam, so 19 materials total.

When you are finished entering parameters, Click on: the “Next Form” button
This opens the “Seam Geometry and Boundary Conditions” form. Based on our mine grid design, we will set:

The “Element Width” to “3” m, the “Number of Elements in X Axis” to “150” and the “Number of Elements in Y Axis” to “150”

We will set the “Seam Boundary Conditions” to “Symmetric” on all 4 sides (see above).
For the first seam ("Current Seam Number" = "1") seam, as we saw in the mine map. We will set:

- the "X Coordinate of Grid Origin" to "854380", the "Y Coordinate of Grid Origin" to "62780",
- the "Overburden Depth" to "300", and the "Seam Thickness" to "1.8" (see above)
We then slide the “Current Seam Number” equal to “2”, and for the second seam (Darby Fork Mine), we set:

the “X Coordinate of Grid Origin” to “854380”, the “Y Coordinate of Grid Origin” to “62780”,
the “Overburden Depth” to “285”, and the “Seam Thickness” to “1.5” (see above)

When finished, Click on: the “Next Form” button
This opens the “Overburden / Rock Mass Parameters” form.

If we had site-specific rock mass data, or some experience/engineering judgment, we might adjust these parameters to better fit our location. However, since we do not have any site-specific information, we can just use the default values and we will get “reasonable” overburden response.

To continue, we click on: the “OK” button
Before we go into the Material Wizard, which needs a **working directory** to do some of the calculations, it is a good idea to save all of the parameters that we have just input so far and establish a working directory.

Go to the **“File”** pull-down menu and Click on **“Save”** and save the file to your desired location.

Enter **“OK”** to a number of pop-up notifications about no seam materials yet. That will be next.
Now, to get back into entering the model parameters

Go to the “Edit-Data” pull-down menu, pull-through the “Material Models >”, and Click on “Create using Material Wizard” (see above)
This opens the “In-Seam Material Wizard” form, on the “Elastic-Plastic for COAL” tab.

This wizard helps the user automatically generate Mark-Bieniawski coal strength materials and is used in conjunction with the automatic yield zone generator in the grid editor to produce coal pillars that follow the Mark-Bieniawski coal strength formula.
We have 2 seams and we want to generate separate coal properties sets for each seam. So,

We leave the “Current Seam Number” set to “1”
We change the “Number of Sets to be Defined” to “2”, and we want
The “Number of Yield Zones per Set” to be equal to “4” (see above)

To actually calculate the coal properties, we click the “Define Set” button.
This button opens a series of pop-up windows that informs the user that:

1) M-B coal properties are going to be automatically generated,
2) 9 COAL materials, A-I will be created, and then
3) 9 Coal material models (A – I) have been defined

Please click the “Yes”, “Yes”, and “OK” buttons to continue through these windows.
Now we want to generate the coal properties for the second seam. So,

We change the “Current Seam Number” to “2” (note that the extraction thickness also changes)

We change the “Current Set Number” to “2”, (note that the form knows that the “Base Code” for set 2 is “J”) and we want

The “Number of Yield Zones per Set” to be equal to “4” (see above)

To actually calculate the second set of coal properties, we click the “Define Set” button.
Again, we see the series of informational pop-up windows.

1) M-B coal properties are going to be automatically generated,
2) 9 COAL materials, J - R will be created, and then
3) 9 Coal material models (J – R) have been defined

Please click the “Yes”, “Yes”, and “OK” buttons to continue through these windows.
Back in the “Elastic-Plastic for COAL Wizard”, we can click on the “Material Summary” button to see a list of the presently defined materials.

(if this button does not work, you need to install the MS Flex Grid, Active X Object (“msflxgrd.ocx”) as described in the FAQS.)
In the material summary, the two sets of coal materials can be seen.

Set 1, with the "LINEAR ELASTIC" base material "A", and "ELASTIC PLASTIC" materials "B – I", and
Set 2, with the "LINEAR ELASTIC" base material "J", and "ELASTIC PLASTIC" materials "K – R".
You can also see that material "S" is not yet defined

When you are done reviewing the materials, please click the "OK" button to go back to the "In-Seam Material Wizard" form.
Back in the “Elastic-Plastic for COAL” Wizard, we click on the “Strain-Hardening for Gob” tab to open that wizard.

In the Gob Wizard, we want to:

Set the “Current Seam Number” to “2” (note that the “Seam Thickness” and “Overburden Depth” change accordingly)

Set the “Width of Gob Area” to “125” m (the width of the gob in the Darby Fork Seam) (see above)
Also, we will check the “Use the Suggested Value” Box to use the recommended 28.5% overburden load on the gob (based on a 21 degree abutment angle).

We will use the given and/or default values for the: “Coal Properties” and “Gob Default Parameters”

We then click the “Calculate” button
An informational pop-up window now appears that informs the user that a 2D Model will be used to calculate the Final Gob Modulus that provides the desired Gob Stress.

Please click the “Yes” button to continue.
The “Strain-Hardening for GOB” wizard then re-appears with the calculated “Final Modulus for Gob” set to 897.67 Mpa.

In order to actually input these gob material properties into material database, the user needs to click the “Define Set” button.
An informational pop-up window now appears that informs the user that the definition of GOB material #1 was successful.

Please click the “OK” button to continue
Back in the “Strain-Hardening for GOB” wizard, we can click the “Material Summary” button to see the materials that are presently defined. If we scroll to the bottom of the list, we can see that material “S” has now been defined as a “STRAIN HARDENING”, “GOB” material with the properties just determined in the gob wizard.

When you are done reviewing the materials, please click the “OK” button to go back to the “In-Seam Material Wizard” form.
We are finished defining in-seam materials, so we click the "Next Form" button to continue.
This opens the “Program Control Parameters” form, which is the last form for entering parameters in this model.

In this form, we will go with the default “Control Options”, but we want to make sure that the “Solution Options” for “Input Topography from Topographic File” and “Calculate Safety Factors” are checked (see above).

To finish entering parameters, we click the “Finish” button
Back in the main LamPre window, it is a good time to save all of the parameters that we have just input.

Go to the “File” pull-down menu and Click on “Save” and save the file to your desired location.

Enter “OK” to a number of pop-up notifications about no seam or grids that may appear.
Back in the main LamPre window, we now want to start working with the mine grids.

So, go to the “Edit-Grid” pull-down menu and Click on “Edit Grids” (see above).
The opens the “Grid Editor” window. (If you do not have experience with the grid editor, please see the “Tutorial 1” tutorial file.)

First, Let’s make the Grid Editor window full screen by clicking on the middle button in the upper right corner of the window.

Then, let’s zoom in as much as possible to get as much of the mine grid on screen as possible.
Please move the Zoom slider the whole way to the left.
Once zoomed in, we see that the grid for “Current Seam Number” “1” is filled with the default property “A”.

To load the seam grid for seam 1 (the Huff Creek Seam) we generated in AutoCAD, we need to

Go to the “Grid” pull-down menu and click on the “Load Text File” command. (see above).
In the “File Open” form, go to your working directory and select the “HCPillars.txt” file created in AutoCAD that contains the mine grid for the Huff Creek Seam.

Double-click this file name, or click the “Open” button.
The seam grid text file for seam 1 is then read into the grid editor, and an informational pop-up window now appears that informs the user that the Input File was Successfully Read. Please click the “OK” button to dismiss this pop-up window.

In real life, at this point, you may want to edit the mine grid to improve the accuracy of the grid representation; however, in this demonstration, we will continue with the grid “as is”.

Now, we want to apply the yield zone for seam 1 with the first set of coal properties.

Make sure that the “Current Set Number” is equal to “1”, and then click on the ”Apply Yield Zone” button

A message appears saying the materials A – I will be applied to the seam grid. Click the “Yes” button to continue.
The seam then appears with the yield zone applied. To go to the next seam, click the “Current Seam Number” slider to the right.

A pop-up window then asks if you want to save the current Seam changes.

Please click the “Yes” button to save the grid from seam 1 and continue to seam 2.
This then brings up the mine grid for seam 2 which is presently filled with default materials.

To load the seam grid for seam 2 (the Darby Fork Seam) that we generated in AutoCAD, we need to

Go to the “Grid” pull-down menu and click on the “Load Text File” command. (see above).
In the “File Open” form, go to your working directory and select the “DFPillars.txt” file created in AutoCAD that contains the mine grid for the Darby Fork Seam.

**Double-click** this file name, or click the “Open” button.
The seam grid text file for seam 2 is then read into the grid editor, and an informational pop-up window now appears that informs the user that the Input File was Successfully Read.

Please click the “OK” button to dismiss this pop-up window
Now, we want to apply the yield zone for seam 2 with the **second set** of coal properties.

Click the “**Current Set Number**” slider to the right until it is equal to “2”, and then click on the ”**Apply Yield Zone**” button

A message appears saying the materials J – R will be applied to the seam grid. Click the “**Yes**” button to continue.
The seam 2 then appears with the yield zone applied. We are now done with building the grids.

To exit the Grid Editor, Go to the “Grid” pull-down menu and click on the “Exit” command. (see above).
A pop-up window then asks if you want to save the changes.

Please click the “Yes” button to save the grid from seam 2 and exit the grid editor.
Back in the main LamPre window, we want to save all of our grid changes and input parameters to the input file.

Go to the “File” pull-down menu and Click on “Save” and save the file to your desired location.
We are done working LamPre.

To exit the program, go to the “File” pull-down menu and Click on “Exit” command.
Now, we want to submit the “HuffCreek.inp” input file to the LaModel solution module and calculate the seam displacements and stresses. (Also, we need to make sure that our topography file “HuffCreek.top” has the same base name (“HuffCreek”) and is in the same directory so that it can be found by LaModel.)

If you have a “LAM” icon on your screen, you can double click on it, or you can use the start menu by Clicking on:

Start=>Programs=>WVU=>LaModel3.0=>LaModel3_0_4.exe
From the Main “LaModel3_0” form, we want to go to the “File” pull-down menu and click on the “Open” command. (see above).

Then locate and select the input file, “HuffCreek.inp”.
Hopefully, if the file is the correct format, a pop-up window appears telling the user that the Input File was Successfully Read.

Please click the “OK” button to dismiss this pop-up window.
Back in the main “LaModel” form, the “Calculation Phase” information box is stating: “Waiting for Run”

At this point, Click the “Run” Button to run LaModel
Within a few seconds this small demonstration model will solve.

First, LaModel propagates the overburden stress to the seams
Then, LaModel goes through a cycle of: calculating seam displacements, and propagating multiple-seam stresses until the same displacement stabilizes.
This concludes the Huff Creek Mine demonstration, but the user may certainly want to go to LamPlt and examine the output as shown in the next few slides.
Single Seam Stress

Vertical Stress (psi)

900  1350  1800  2250  2700  3150  3600  4050  4500  5050  5400
Multiple Seam Stress

Multiple-Seam Stress (psi)

-1000 -650 -300 50 400 750 1100 1450 1800 2150 2500
Thank You

Dr. Keith A. Heasley
Associate Professor
Department of Mining Engineering
West Virginia University